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[bookmark: _Toc201929937]ABSTRACT
The NDSU disquisition templates are designed for your convenience, but they will require additional formatting to fit the style manual of your discipline. Furthermore, we recommend reading the accompanying manual for these templates, located on our website: www.ndsu.edu/cfwriters/disquisitions/guidelines-templates-forms.
This page is required as page “iii” of the disquisition. Use the “NDSU Paragraph Double Space 0.5 First Line” style for the paragraph text. Abstracts for doctoral dissertations must use 350 words or less. Abstracts for master’s papers or master’s theses must use 150 words or less. Note: This abstract will be used in your publication entry in the online repository.
[bookmark: _Toc201929938]ACKNOWLEDGMENTS
Acknowledgments text should be placed here. In this section you can acknowledge or thank those who assisted or supported you in your disquisition, and you can acknowledge any external funders that may have supported your project with grant funding. Use the “NDSU Paragraph Double Space 0.5 First Line” style for the paragraph text. This page is optional—delete if not using.
[bookmark: _Toc201929939]DEDICATION
This section dedicates the disquisition to a few significant people. 
The text must be double spaced and aligned center to the page with no paragraph indents. This page is optional—delete this page if you are not using it.
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[bookmark: _Toc201929940]LIST OF TABLES
Table	Page
1. 	Title of table in “NDSU Table Title” style, which uses the same font typeface and font size as the paragraph text, single spaced. Table titles using this style are automatically placed into the List of Tables. Right-click the list and update it to pull the title into the list. After updating a prefatory list, remove the “table” and “figure” label from in front of each number and apply the “List Entry: Tables, Figures, Etc” style to the entries. You may need to fix the alignment of the entries after updating. If you use bold for the table and figure numbers in the chapters, as this template does, remove the bolding in the List of Tables/Figures when you update the entries.	2
2. 	Title of table in “NDSU Table Title” Style from the Styles pane.	2
[bookmark: _Hlk201922169]NOTE TO USER: To populate the List of Tables with titles and to update with changes, right click on the entries, choose “Update Field” then choose to update the page numbers only or update the entire table if you made changes to or added new table titles. When you update the whole table you will have to reformat the list to manually remove the label word “Table” from each entry, and realign the entries. Use the style “List of Tables Figures entry” to help with formatting and Tab settings to align entries. DELETE THIS NOTE BEFORE YOU SUBMIT YOUR DISQUISITION.
[bookmark: _Toc201929941]LIST OF FIGURES
Figure	Page
1. 	Title of figure in “NDSU Figure Title” style. Note that the style automatically places 18 pts of line spacing after figure titles; if you include a figure note, you will need to manually adjust this line spacing, as there should be no more than one line of space (roughly 12 pts) between a figure title and a figure note.	2
2. 	Title of the figure. Caption or notes of the figure. If you elect to add a separate note below this title/caption, as in figure 1 above, you may need to manually remove the line spacing from the figure title/caption (line spacing can be set in the paragraph settings).	2

NOTE TO USER: To populate the List of Figures with titles and to update with changes, right click on the entries, choose “Update Field” then choose to update the page numbers only or update the entire table if you made changes to or added new table titles. When you update the whole table you will have to reformat the list to manually remove the label word “Figure” from each entry, and align the title column. Use the style “List of Tables Figures entry” to help with the formatting and Tab settings to align entries.  DELETE THIS NOTE BEFORE YOU SUBMIT YOUR DISQUISITION.
[bookmark: _Toc201929942]LIST OF _______
Item 	Page
1. 	Title of example is formatted in “NDSU Other Item Title”. You can use this style to make the list of items that you need and update the entries in the extra “LIST OF ____” after the LIST OF FIGURES in the prefatory section.	2

NOTE TO USER: If you have non-text items other than tables or figures in your disquisition, you may need to label them and list them in a prefatory directory like this one. Examples include musical examples, schematics, code examples, algorithms, equations… You can relabel the title and column header of this page to suit your needs and populate it with the item titles formatted with the style “NDSU Other Item title”. DELETE THIS NOTE BEFORE YOU SUBMIT YOUR DISQUISITION.
[bookmark: _Toc201929943]LIST OF ABBREVIATIONS
Abbreviation	Explanation of the Abbreviation. Remove this entry before submitting your disquisition.
[bookmark: _Hlk201922296]Directions	This page has been formatted with an automatic dot leader and our required alignment. Press “Enter” after the previous definition to start a new entry. After typing the abbreviation, press “Tab” once to get the Dot Leader up to the definition column. There is also a Style for these list entries: “List Entry Abbreviations, Symbols”. Remove this entry before submitting your disquisition.
ETD	Electronic Thesis or Dissertation
[bookmark: _Toc201929944]LIST OF SYMBOLS
[bookmark: _Hlk201920707]Symbol	Explanation of Symbol. If the symbol text runs longer than one line, the subsequent lines are aligned with the first word in the entry. Remove this entry before submitting your disquisition.
Directions	After entering the Symbol, press Tab to get an automatic dot leader to the definition column. After typing the definition, press Enter to start a new line for a new symbol. Remove this entry before submitting your disquisition.
X	Definition
Y	Definition
[bookmark: _Toc201929945]LIST OF APPENDIX TABLES
Table	Page
A1. 	Title of appendix table in “NDSU Appendix Table Title” style from the Styles pane. Appendix tables should include the letter of the appendix in its number (if you have only one appendix, then use the default letter “A” in the number).	2
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[bookmark: _Toc201929947][bookmark: _Hlk201922362]MAJOR HEADING FOR FIRST CHAPTER USING STYLE “NDSU 1 MAJOR HEADING/CHAPTER TITLE”
[bookmark: _Hlk201922402]Use our NDSU Styles to simplify your formatting. If you are pasting in text from another source, we recommend using Ctrl+Alt+V to Paste Special – Unformatted Text, which will remove other formatting that may be on that text. Then, apply the appropriate formatting from the Styles Pane. For paragraph text, use the style “NDSU Paragraph Double Space 0.5 First Line.” 
[bookmark: _Hlk201922387]For bulleted list items, use the “NDSU Bullets” style from the styles pane. Bulleted and numbered lists should be formatted consistently throughout the document.
[bookmark: _Hlk201929464]Use styles to auto-populate and update the Table of Contents and Lists of Tables/Figures/etc. For headings, use the styles marked “NDSU”: NDSU 1, NDSU 2, NDSU 3, NDSU 4, and NDSU 5. For non-text items, use the styles marked as “table”, “figure”, or “other item”. You can make modifications to the styles if necessary—refer to our user guide (“How to Use NDSU Disquisition Templates” on our Disquisition Formatting Guidelines web page) and our Formatting Tutorial videos on the GPS Academy YouTube channel for more information about formatting with styles, modifying styles to fit your style manual’s guidance, and using and adjusting this template.
[bookmark: _Hlk201922598]Note that you not be able to automatically populate and update the Table of Contents and prefatory lists if styles are not used appropriately for their respective items. 
[bookmark: _Toc201929948]First Level Subheading Using Style “NDSU 2”
[bookmark: _Hlk201922610]An example table is below. Your tables and table titles can look different from the example; we encourage you to follow the style of your discipline, but your tables must stay within our guidelines. A consistent design is required for all of your tables, including the line spacing above and below your tables, and no tables should extend into the 1” page margins. The line spacing options in the styles have been set for their most common use, and are not intended to work for all situations; you will need to review the line spacing options for non-text items on a case-by-case basis.
[bookmark: _Toc201929838][bookmark: _Hlk201926686][bookmark: _Hlk201926830]Table 1. Title of table in “NDSU Table Title” style, which uses the same font typeface and font size as the paragraph text, single spaced. Table titles using this style are automatically placed into the List of Tables. Right-click the list and update it to pull the title into the list. After updating a prefatory list, remove the “table” and “figure” label from in front of each number and apply the “Prefatory List” style to the entries. You may need to fix the alignment of the entries after updating. If you use bold for the table and figure numbers in the chapters, as this template does, remove the bolding in the List of Tables/Figures when you update the entries.
	Column 1
	Column 2
	Column 3
	Column 4

	Row 1
	“Table text” style
	Data
	Data

	Row 2
	Data
	Data
	Data


[bookmark: _Hlk201926783]Note: The “NDSU Table Note” style is used to format table notes, including line spacing. Table notes are single spaced and have the same font typeface and font size as the paragraph text. If you do not have a table note, you will likely need to change the line spacing manually after the table. See our website or the text at the bottom of page 9 in the appendix for more information. 
[bookmark: _Toc201929949]Second Level Subheading in Style “NDSU 3”
[bookmark: _Hlk201922756]Paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text.
[bookmark: _Hlk201927103]Third Level Subheading in Style NDSU 4
A sample figure is below. Use the “NDSU Figure” style to center your figures. For inserting figures, we recommend that you do not anchor them and do not wrap text around them; instead in line with text and center them. Follow your discipline’s style guide for figure title format—it may differ from our template’s examples. 
[bookmark: _Hlk201922859]Table and figure titles should be on the same page as table or figure itself. If a table or figure can fit on the same page as its title and notes, all of that table or figure—including its title and/or notes—should appear on one page, regardless of whether it creates a large gap in your content. If an item is too large to fit onto a single page, see the Format Guidelines on how to create multi-page tables and figures.
[image: ]
[bookmark: _Toc201929804][bookmark: _Hlk201923017]Figure 1. Title of figure in “NDSU Figure Title” style. This style automatically places 18 pts of line spacing after figure titles; if you include a figure note, you will need to manually adjust this line spacing, as there should be no more than one line of space (12 pts) between a figure title and a figure note. This spacing is demonstrated here.
Note: This style (Figure note) is used for any notes related to a figure. If you use a table, figure, or non-text item that is not your original design, you must cite the original source of the item and obtain any necessary permissions according to copyright. Refer to the style manual of your discipline for more information about citations of non-text items.
Fourth-level Subheading in Style “NDSU 5”
[bookmark: _Hlk201923601]Below is a musical example. Things like schematics, musical examples, and some other non-text items should be labeled and titled and entered in an appropriate list in the prefatory section. (There are some exceptions—when in doubt, follow the conventions of your discipline and consider the needs of your reader.) Additionally, note that the whitespace between the end of this paragraph and the bottom of the page is acceptable to ensure that the musical example appears on the same page with its title and notes.
[image: ]
[bookmark: _Toc148027178]Musical Example 1. Title of example is formatted in “NDSU Other Item Title”. You can use this style to make the list of items that you need and update the entries in the extra “LIST OF ____” after the LIST OF FIGURES in the prefatory section.
Note: This style (NDSU Other Item Note) is for notes related to the other item.
[bookmark: _Toc201929950]MAJOR HEADING USING STYLE “NDSU 1: MAJOR HEADING/CHAPTER TITLE”[footnoteRef:2] [2:  If your chapter is using or reproducing content that is now or will be published, and that content has co-authors listed in the publication, then you must include a footnote to the chapter title with the appropriate acknowledgments, including any instructions from the publisher to cite the publication. These acknowledgements are mandatory and must follow the Graduate School’s guidelines for describing your role in the co-authorship. Details and an example are on our General Requirements web page under “Copyright”. To insert a footnote, go to the References tab in the Word ribbon and click “Insert Footnote”—do not place it in the footer.] 

[bookmark: _Toc147744725][bookmark: _Hlk201924277]You should review your document before and after it has been printed to PDF to ensure its compliance with the Format Guidelines. You can view formatting marks using the “Show/hide formatting marks” button on the Home tab in the Paragraph section (Ctrl+Shift+8). Some formatting is embedded in styles for your convenience; for example, the major heading style automatically forces the heading to appear at the top of a new page. We do not recommend using line breaks (Enter) to space out content, as any changes to line spacing or other formatting above the line breaks will likely cause issues for content below the line breaks. Instead, if you need to force content onto a new page—such as a full page table or figure—insert a page break on the Insert tab. Warning: Use page breaks, not section breaks, unless you are inserting landscape pages.
[bookmark: _Toc201929951]First Level Subheading in Style “NDSU 2”
[bookmark: _Toc147744727]Paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text.
[bookmark: _Toc148017014][bookmark: _Toc201929839]Table 2. Title of table in “NDSU Table Title” Style from the Styles pane.
	Column 1
	Column 2
	Column 3
	Column 4

	Row 1
	
	
	

	Row 2
	
	
	


Note: This style (NDSU Table Note) is used for any table notes.
[bookmark: _Hlk201924462]If you use equations in your text, they should be centered to help them stand out from the paragraph text. If you number the equations, they must be numbered consecutively throughout the document (1, 2, 3, and so on) or consecutively within each chapter (1.1, 1.2, 2.1, 2.2, and so on), and the equation numbers must be flush against the right margin. You can set tabs to format these: a 3.25” centered tab is used for the equation and a 6.49” right tab is used for its number.
		(1)
		(2)
[bookmark: _Toc147744729]More details on tab settings for equations can be found in our “How to Use NDSU’s Disquisition Templates” documents on our formatting guidelines web page.
[image: ]
[bookmark: _Toc201929805][bookmark: _Hlk201924769]Figure 2. Title of the figure. Caption or notes of the figure. If you elect to add a separate note below this title/caption, as in figure 1 above, you may need to manually remove the line spacing from the figure title/caption (line spacing can be set in the paragraph settings).
If you are using a figure title without figure notes, make sure there is a single line of space (12 points of space) between the figure title and other content below (text, subheading, other non-text item, etc.).
[bookmark: _Toc201929952]REFERENCES
[bookmark: _Hlk201924858]Citation example using the “NDSU Citation” style. This style is double spaced with a hanging indent, but you are welcome to use a format that fits your disciplinary conventions. 
[bookmark: _Hlk201924843]Follow your discipline’s style guide for reference list formatting guidance and modify our style as needed. 
[bookmark: _Hlk201924850]Use only one citation style. For example, do not mix APA and AMA citation styles in your document.
[bookmark: _Hlk201924805]Before submitting your document, proofread all entries. Citations that have been automatically generated by citation management software likely have missing information or inconsistent formatting. Double-check all citations for accuracy and completeness, paying special attention to capitalization, punctuation, author names, font style, consistency in how you list journal titles (e.g., full vs. abbreviated, italicized), and compliance with the citation style manual you are using.
Citation citation citation citation citation citation citation citation citation citation citation citation citation citation.
[bookmark: _Toc201929953]APPENDIX A. HEADING FOR APPENDIX USING “NDSU 1” STYLE
[bookmark: _Toc147744732][bookmark: _Hlk201924905]Please read our appendix format guidelines thoroughly, as they contain specific instructions pertaining to how your appendix material should be presented. 
If you have only one appendix, then remove the letter A from the major heading, but keep using the letter A in any table and figure numbers to denote that they are appendix tables and figures.
[bookmark: _Toc148016770][bookmark: _Toc201927547][bookmark: _Toc201929748]Table A1. Title of appendix table in “NDSU Appendix Table Title” style from the Styles pane. Appendix tables should include the letter of the appendix in its number (if you have only one appendix, then use the default letter “A” in the number).
	Column 1
	Column 2
	Column 3
	Column 4

	Row 1
	“Table text” style
	
	

	Row 2
	
	
	


Note: This style (NDSU Table note) is used for any table notes.
[image: ]
[bookmark: _Toc148016202][bookmark: _Toc201929714]Figure A1. Bison art created in a beta version of Adobe Firefly, a generative AI app. Title of appendix figure in “NDSU Appendix Figure Title” style.
Note: This style (NDSU Figure Note) is used for any figure notes. Remember that the value of academic accountability must guide the use of AI tools, and you must cite any AI-generated work.
[bookmark: _Toc201929954]APPENDIX B. HEADING FOR SECOND APPENDIX USING STYLE “NDSU 1”
[bookmark: _Toc201927548][bookmark: _Toc201929749]Table B1. Resources and more information for disquisition writers.
	NDSU Website
	For more information about:

	Graduate School Current Students
	Graduate School policy, deadlines, forms, graduation

	· https://www.ndsu.edu/gradschool/current_students

	Graduate School Dissertations, Theses, and Papers
	Disquisition policies, formatting guidelines, templates, a guide to using the templates, submission procedures, publication and delayed release information

	· https://www.ndsu.edu/gradschool/current_students/graduation/papers_theses_dissertations

	Center for Writers
	Writing consultations, writing workshops, disquisition boot camps, writing resources on site and online

	· www.ndsu.edu/cfwriters/

	Learning and Applied Innovation Center (LAIC)
	Thesis formatting workshops. Help with our template. Help with using Microsoft Word and other software applications. Walk-in consulting service in Quentin Burdick Building 150C, or schedule an in-person or virtual appointment with their thesis formatting specialist. Note: The LAIC does not consult on guidelines nor conduct reviews of your formatting. See them for technical help carrying out formatting functions.

	· https://www.ndsu.edu/it/help/laic/

	Formatting Tutorial Videos
	Hosted on the GPS Academy YouTube Channel. “Navigating the Review Process” workshop recording and “Word Crash Course” videos on In-Paragraph Formatting; Styles; Section Breaks and Page Numbers; Table of Contents; Tables and Figures; Landscape Pages and More about Tables; Template Overview.

	· https://youtube.com/playlist?list=PLWKsN3lW50IexOpLRkNjh2HDuVKp3XjFH&si=Cksb4ZlFK3X1uCCh



[bookmark: _Hlk201925230]For any tables without notes, you will need to set the line spacing beneath the table manually. For example, the blank line above this text has been formatted to be single-spaced with 6 pts of additional line spacing in order to maintain the correct line spacing after the table. (12 pts for the blank line plus 6 pts equals 18 pts total, the same as for tables with notes.)
8
image1.jpeg




image2.png
Flute

B Clarinet ==





image3.jpg
NDSU A




image4.jpeg




